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New features in this release

The following new features are available in the release of SAP Visual Intelligence:

DescriptionFeatureVer
sion

You can apply filters in your query while acquiring data
from a Universe data source.

Query filters in Universe data
source1.06

New support for IBM DB2 data access drivers for
Freehand SQL data access.IBM DB2 Freehand SQL support

1.04

You can apply trend and linear regression analysis on
bar and line charts.Predictive analysis

You can export a dataset to a SAP Explorer CMS. The
dataset can be used to create an information space.Export to SAP Explorer

You can implement moving average calculations.Moving average calulations

You can use latitude and longitude data to create new
geography hierarchies.

Customized geography hierar-
chies

You can acquire data from SAP BusinessObjects uni-
verses by creating queries and visualize data using
SAP Visual Intelligence.

Universe data access1.03

You can create your own data provider by manually
entering the SQL for a target data source.Freehand SQL data access

1.02

You can publish documents to activities in SAP
StreamWork.Publish to StreamWork

You can import SViD files to the Documents folder.Import to folder

The Proxy tab allows you to enter the proxy server in-
formation for auto-update and StreamWork publishing.
The Freehand SQL tab contains the list of database
middleware supported by SAP Visual Intelligence. You
use this list to determine if your database middleware
has the correct data access driver installed to use
Freehand SQL.

New Proxy and Freehand SQL
tabs in Preferences.
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Related Topics
• Working with Freehand SQL
• Publishing documents to SAP Streamwork
• Setting application preferences
• Working with data from a universe
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Release restrictions

The following are the known issues and limitations in this release:

Limitations
• If SAP Visual Intelligence does not start, verify that the environment variables _JAVA_OPTIONS,

and JAVA_TOOL_OPTIONS are not present in the environment. If they are present, remove them
and restart SAP Visual Intelligence.

• In this release, using the Universe data source, you can acquire data only from BI 4.0 Unv files and
BI 4.0 Unx files connected to relational databases

• Acquiring data from the following types of universes is not supported:
• Universes that exists on the XI 3.x platform
• BI 4.0 Unx file connected to an OLAP data source
• Universes connected to the SAP BW data source

• Tabular and hierarchical LOVs are not supported in query filters for a Universe data source.
• Cannot set time for a DateTime dimension object in SAP Visual Intelligence.
• Cannot change the answered prompt value after acquiring data from a Universe data source.

Release Notes
• An error occurs when you attempt to access huge data (more than 300000 cells) from a universe

data source.

Workaround: The default value of Web Intelligence Processing Server (Web Intelligence Report
Server) configuration parameter "Maximum Character Stream Size (MB)" is too low (5MB) for the
output. Increase this value in the Central Management Console (CMC).

• When acquiring data from a universe, if the query returns a partial result, the message is not displayed
in SAP Visual Intelligence.

• If you select the preview data option when acquiring data from a universe, measures are not mapped
to the measures section by default.

Workaround: Measures are mapped properly if the preview option is not selected.
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SAP Visual Intelligence overview

3.1 SAP Visual Intelligence overview

SAP Visual Intelligence is a data manipulation and visualization tool. You can connect to various data
sources, select and clean data, manipulate and visualize data with a diverse offer of graphical charts
and tables. SAP Visual Intelligence is installed locally and can operate on data either remotely or on
locally stored datasets. The charts that are created can be saved and sent out by email. Your datasets
can be published to SAP Hana, and documents published to Streamwork activities.

The charts that you create in SAP Visual Intelligence are saved in documents with the file format .SViD.
This is a document that contains the data source connection information, the data definition and data,
and the graphic visualizations.
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Installing SAP Visual Intelligence

4.1 Installation prerequisites

Before installing SAP Visual Intelligence, make sure the following requirements are met:
• You must install the application on a 64-bit machine.
• You must have Administrator rights to install SAP Visual Intelligence on the computer.
• Sufficient disk space must be available on the following resources:

Required spaceResource

2.5 GBDrive hosting the User application data folder

200 MBUser temporary folder (\AppData\Local\Temp)

500 MBDrive hosting the installation directory

Tip:
If the prerequisite check summary page opens indicating that port 6401 is not available, you can
specify a value for the Sybase IQ database using the IQPort parameter. For more information see
To perform a silent installation.

• The following ports must be available:

Required byPort

Sybase IQ database6401

SAP Visual Intelligence installationAny port in the range 4520-4539

• To acquire data from universes that exists on the BI 4.0 platform, ensure that Web Intelligence
Server is up and running. And also ensure that your Business Intelligence platform is at BI 4.0 SP2
patch level 14 or above. However, you can also acquire data from universes that exists on BI 4.0
SP3 and BI 4.0 SP4 platforms.

The SAP Visual Intelligence Setup program will check for these prerequisites.
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4.2 Using the SAP Visual Intelligence Setup program

The SAP Visual Intelligence Setup program is contained within the self-extracting archive - SAPVisu
alIntelligenceSetup.exe. The program is an installation wizard that guides you through the the
installation of the required SAP Visual Intelligence resources on your computer. The program
automatically recognizes your computer's operating system and checks for platform requirements. It
updates files as required.

For a current list of supported platforms, and information about specific platforms and configurations
for SAP Visual Intelligence, refer to the following page: https://websmp103.sap-ag.de/pam.

4.2.1 To install SAP Visual Intelligence using the setup program

1. Navigate to the SAP Visual Intelligence self-extracting archive - SAPVisualIntelligenceSetup.exe

- and double-click the icon.

The SAP Visual Intelligence Setup program is extracted from the archive. The Installation Wizard
performs a verification check for all of the installation prerequisites. A prerequisite summary page
opens only if the verification fails for any requirement. Close the wizard and correct any missing
prerequisite before relaunching SAPVisualIntelligenceSetup.exe.

If all of the installation prerequisites are confirmed, the "Welcome" page opens.

2. Click Next.
The "License Agreement" page opens.

3. Review the License Agreement. When you are ready, select I accept the License Agreement and
click Next.
The "Installation Destination" page opens.

4. Specify where you want SAP Visual Intelligence installed:
a. Click Next to accept the default installation directory.

OR
b. Type the path, or click Browse to navigate to the location where you want to install SAP Visual

Intelligence. Click Next.
The "Start Installation" page opens. You are now ready to install SAP Visual Intelligence.

5. SAP Visual Intelligence. Click Next to proceed with the installation.
The installation is complete when the "Finish Installation" page opens.

6. To automatically launch the application, select Launch SAP Visual Intelligence after installation
completes. Click Finish to close the wizard.
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4.3 Performing a silent installation

Using a silent installation, system administrators can run a script from the command line to automatically
install SAP Visual Intelligence on any machine in their system without the setup program prompting
them for information or displaying the progress bar. The silent installation is primarily geared towards
users with network administration roles. A silent installation is particularly useful when you need to push
multiple installations in your corporate network. Once you have created a silent installation response
file, you can add the silent installation command to your installation scripts.

4.3.1 To perform a silent installation

You can use the SAP Visual Intelligence self-extractor to create a response file required for a silent
installation. Follow the instructions below to create a response file and perform a silent installation.
1. Click Start > Run and type cmd to open a Command Prompt window.
2. Navigate to the SAP Visual Intelligence self-extracting archive, SAPVisualIntelligenceSet

up.exe.
3. Run the following command:

SAPVisualIntelligenceSetup.exe -w <response_filepath>\response.ini

The SAP Visual Intelligence Setup program opens.

Tip:
If the prerequisite check summary page opens indicating that port 6401 is not available, you can
specify a value for the Sybase IQ database using the IQPort parameter.
SAPVisualIntelligenceSetup.exe -w <response_filepath>\response.ini IQPort=<Port_Number>

The IQPort parameter by default is not included in the response.ini file. It is used specifically
to unblock the installation setup when the expected port is not available. You will have to manually
add this parameter to the file or provide it on the command line when running an installation.. See
Additional installation options.

4. Follow the installation wizard to select your SAP Visual Intelligence setup options.
5. On the "Start installation" page, click Next.

The setup program writes your installation options to the response.ini file, and closes.

Tip:
You can now open response.ini in a text editor to review your setup selections.

6. To run the silent installation, open a Command Prompt window and enter the following command:
SAPVisualIntelligenceSetup.exe -s -r <response_filepath>\response.ini
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The parameter -r requires the name and location of the response file as specified in Step 3. The
optional parameter -s is used to hide the self-extraction progress bar during the silent installation.

Note:
If you specified the IQPort parameter in Step 3 but did not add this configuration detail to the
response file, you will have to specify the setting when running the silent installation.

4.3.2 Additional installation options

You can specify additional setup options when installing SAP Visual Intelligence through the command
line - executing either an interactive installation or a silent installation. These additional options are
listed below and are not available in the installation wizard..

Installation modeDescrip
tion

Pa
rame
ter

Interactive installation:

SAPVisualIntelligenceSetup.exe IQPort=<port number>

Silent installation:
SAPVisualIntelligenceSetup.exe -s -r <response filepath>\response.ini IQPort=<port
number>

If the
6401 port
is not
available,
you can
specify a
value for
the
Sybase
IQ
database
using this
parame-
ter.

IQ
Port

Interactive installation:

SAPVisualIntelligenceSetup.exe LicenseKey=<license key>

Silent installation:
SAPVisualIntelligenceSetup.exe -s -r <response filepath>\response.ini LicenseKey=<li
cense key>

You can
use this
parame-
ter to
specify an
SAPVisu-
al Intelli-
gence li-
cense key
to use
when run-
ning the
installa-
tion.

Li
censeKey

2012-10-2216

Installing SAP Visual Intelligence



The IQPort and LicenseKey parameters can be specified together on the command line. They can
also be added together to the response file.

4.4 Uninstalling the SAP Visual Intelligence application

There are two ways to uninstall SAP Visual Intelligence from your machine:
• Using the Uninstall SAP Visual Intelligence shortcut from the Start menu. OR
• Deleting the SAP Visual Intelligence program using the uninstall utility in Control

Panel\Programs\Programs and Features.

4.4.1 To uninstall SAP Visual Intelligence

1. To remove SAP Visual Intelligence from your machine:
• Click the Uninstall SAP Visual Intelligence shortcut in the Start menu. OR
• Right-click SAP Visual Intelligence in Control Panel > Programs > Programs and Features

and select Uninstall.
The "Uninstall Confirmation" page opens.

2. Click Next.
SAP Visual Intelligence is removed from the machine when the "Finish Uninstallation" page opens.

3. Click Finish to close the installation wizard.

4.5 Important considerations for using SAP HANA

This section contains important considerations and requirements for using SAP Visual Intelligence with
the SAP HANA database.

Security requirements for publishing to SAP HANA
Before users can publish content to SAP HANA, they must be assigned specific privileges and roles.
These roles and privileges are also required for retrieving data from SAP HANA. Use the SAP HANA
Studio application to assign user roles and privileges. For information on administrating the SAP HANA
database and using SAPHANAStudio see SAPHANADatabase – Administration Guide. For information
on user security see the SAP HANA Security Guide (Including SAP HANA Database Security).

The user account used to log into the HANA system from SAP Visual Intelligencemust be assigned to
the "MODELING" role (in HANA).
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Note:
This action can only be performed by user with ROLE_ADMIN privileges on the SAP HANA database.

When an SAP Visual Intelligence user logs into the SAPHANA system, the internal _SYS_REPO account
must:
• Be granted the SELECT SQL Privileges.
• Have the Grantable to others option selected on the (SAP Visual Intelligence) user's schema.

4.5.1 To configure  _SYS_REPO for the SAP Visual Intelligence user

If an account for the SAP Visual Intelligence user is already defined in the SAP HANA system:
1. From the system connection in the SAP HANA StudioNavigator window, go to Catalog >

Authorization > Users.
2. Double-click the _SYS_REPO account.
3. Under the SQL Privileges tab, click the + icon, and enter the name of the user's schema, click OK.
4. Choose SELECT and the corresponding Yes under Grantable to others.
5. Click Deploy or Save.

Note:
Users can also open an SQL editor in SAP HANA Studio and run the following SQL statement:
GRANT SELECT ON SCHEMA <user_account_name> TO _SYS_REPO WITH GRANT OPTION

4.5.2 Supported OLAP measures

SAP HANA supports only the following measures of aggregation in OLAP data sources

• SUM
• MIN
• MAX
• COUNT

If your dataset contain an aggregation on a measure that is not listed above, the aggregation will be
ignored by SAP HANA during publication and it will not be part of the final published artifact.
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Getting started with SAP Visual Intelligence

5.1 Using SAP Visual Intelligence from start to finish

The following is an overview of the process you can follow to build a chart on data. The process is not
a linear one, and you can pass from one step back to a precedent step to fine tune your chart or data.

DescriptionSteps to work with your da-
ta

If your data source is:
• RDBMS: Enter your credentials, connect to the database server,

browse and select a data source; for example if you are connecting
to SAP HANA, you select a view and cube to build your chart.

• Flat file: Choose the columns to be acquired, trimmed, or shown
and hidden.

• Universe: Enter your universe credentials, connect to the Central
Management Server repository, and select a universe to build your
chart.

Connect to your data source.

The data acquired can be viewed as columns or as facets. You can
organize the data display to make chart building easier by doing the
following:
• Create filters and hide unneeded columns.
• Create measures, time and geography hierarchies.
• Clean and organize the data in columns using a range of manipu-

lation tools.
• Create columns with formulas using a wide selection of available

functions.

View and organize the
columns and attributes.

You can build charts using:
• Split view that shows the dataset and the chart being built.
• Visualize view to work in a totally graphical environment when

building your chart.
The selection of charts is arranged by family at the top of the Visual-
ization pane.

Choose a chart type.
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DescriptionSteps to work with your da-
ta

You can build charts in three ways:
• Using the Chart feeder panel to the left of the Visualization Pane.
• Directly on the chart body area by draggingmeasures and attributes

onto the chart body.
• Directly on an attribute: Select an attribute or measure, click the

arrow to the right of the object name and selectMake a new chart
with or Add to current chart from the context menu.

Build your chart

Name and save your document that includes your charts. It is stored
locally in the application folder under Documents in your profile path.Save your document

You can do the following with your data, chart, or both:
• Share your chart
• Export your dataset to a file
• Publish your data to SAP HANA as an analytic view
• Publish your data and charts to Streamwork

Share your data or chart

Related Topics
• Connecting to an SAP HANA cube
• Finding your way around the user interface
• Filtering data in columns and charts
• Preparing your data
• Visualizing your data
• Sharing your charts and datasets
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Connecting to your data sources

6.1 Acquiring data from your data sources

You can acquire data from the following data sources:
• C.S.V file
• SAP HANA cube
• MS Excel
• Freehand SQL
• SAP BusinessObjects Universe

Each data source can be adapted before acquisition to include or remove columns. For certain data
sources you have other options, for example data formatting, column naming and trimming, and specifying
column name prefixes. The acquisition options are described for each individual data source.

Note:
For data that is acquired to manipulate locally the maximum number of cells that can be acquired is 15
million. Spreadsheets with more than this maximum are cut off at this point.

Related Topics
• Working with CSV files
• Working with SAP HANA views
• Connecting to an Excel file
• Working with Freehand SQL
• Connecting to a universe datasource

6.2 Number and date formats applied in Visual Intelligence

Java standard number and date formats for the locale defined in your regional settings are used in SAP
Visual Intelligence. Customized number or date formats are not taken into account by SAP Visual
Intelligence, as the Java standard will be applied for the specified locale. For example, if your locale is
France, then SAP Visual Intelligence applies the Java standard number and date formats for the French
language when data is acquired. Any customized settings for the France locale settings are not taken
into account.
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For information on the standard number and date formats used in Java, refer to your Java documentation.

Note:
You can keep the number and date format used in a .CSV file datasource by selecting the Keep this
format for visualization check box in the Acquisition options section of the connection dialog box
when you select a .CSV file to acquire data.

6.3 Working with CSV files

You can acquire data from a comma-separated values (CSV) file. A CSV file stores numbers and text
in plain-text form. Records are separated by line breaks, and each record consists of fields usually
separated by a comma or tab.

In the following example, fields are separated by commas:
"Product","Country","Year","Quantity","Margin"
"Ski Mask","Italy","2,005","1,297","1,929"
"Sino CRT TVs","Italy","2,005","609","10,659"
"PC Systems","UK","2,005","360","37,800"
"Rappel Mountain Bicycle","Canada","2,007","6,681","224,477"

In SAP Visual Intelligence, the file produces four columns; Product, Country, Year, and Margin, with
each row value corresponding to its column based on its position delimited by the comma separators.

You have the following options when choosing your CSV file:

DescriptionAcquisition options

You select which delimiter is used to specify columns in the ac-
quired data.

Delimited by:
• Tab
• Semicolon
• Comma
• Space
• Other

If you do not select this option, the column names are by default
numbered, for example Column1, and Column2.Set first row as column names

Remove characters after or before a specified punctuation mark
or a character.Trim values

You can specify a prefix that applies to all columns.Default column name prefix

Select to keep the number and date formats specified in the
.CSV. If this option is not selected, then the Java standard
number or date format based on the machine locale is applied.

Keep this format for visualization
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Related Topics
• Connecting to a CSV data file

6.3.1 Connecting to a CSV data file

You can connect to a Comma-separated values (CSV) data file as a data source.
1. From the Welcome screen, click New Document .
2. Click CSV.
3. Browse to and select a .CSV file.

The data appears in the preview pane.

4. Select options to specify how the data is presented. The options are described in Related Topics.
The preview is automatically updated with your option choices.

5. Click Acquire .
The data appears in the Data pane.

Related Topics
• Working with CSV files

6.4 Working with Freehand SQL

You can create your own data provider by manually entering the SQL for a target data source. You
need to be familiar with your database and the SQL language to use freehand SQL. You can specify
the source tables, columns, and functions to acquire data. You can use freehand SQL for the following
database middleware:

VersionDatabase middleware

2005, 2008, 2012Microsoft SQL Server

10, 11Oracle

15Sybase IQ

12, 13Teradata

9, 10IBM DB2
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Using Freehand SQL requires that the correct data access driver is installed for your database
middleware. A data access driver is the software provided by a database vendor that allows a client
application to connect to the middleware and access the data in the database. The data access driver
for your middleware must be copied from your database vendor support website to a local folder. From
SAP Visual Intelligence you can then browse to and select the driver to connect to the database. SAP
Visual Intelligence provides a guide to choose and install your data access driver from the Freehand
SQL tab in the Preferences dialog box.

Note:
Installing data access drivers from the vendor sites can be problematic due to the choice of different
driver versions and file formats. If you are not familiar with your database version, or the vendor website,
it is recommended that you refer to your database administrator for information.

Related Topics
• Installing data access drivers
• Connecting to a Freehand SQL data source
• Specifying Freehand SQL connection properties

6.4.1 Installing data access drivers

The Sybase IQ 15 data access driver is provided and automatically installed with SAP Visual Intelligence.
For other databases you may need to install the JDBC data access driver for your database middleware
before using Freehand SQL. The data access driver is a .JAR file that you download from a database
vendor site and copy to a local folder. You then register the driver path by browsing to and selecting
the driver from within SAP Visual Intelligence.

You are guided through the download process from the Freehand SQL tab in the Preferences dialog
box.

You can install a data access driver either when choosing a Freehand SQL data source, or by at any
time by accessing the Preferences dialog box directly from the File menu.
1. Activate the Freehand SQL tab in one of two ways:

• Select File > Preferences, then click the Freehand SQL tab.
• Select New Document then click the Freehand SQL datasource option. A list of database

middleware appears. If the middleware for the database that you want to access using Freehand
SQL appears with a red cross, then the driver is not installed for that middleware and you must
install a driver. The rest of this procedure shows you how to install a driver. Click a database
middleware name in the list that appears with a red cross, then click the Show Preferences
button in the right panel

Note:

• If your middleware has a green check, then you can start using Freehand SQL.
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• When a compatible driver is available for a middleware, but SAP Visual Intelligence has not
been restarted, a yellow question mark icon displays. When you restart you can use Freehand
SQL directly.

The Preferences dialog box appears with the Freehand SQL tab active. The database middleware
names are listed with the accompanying green and red driver indications.

2. Click a database middleware indicated with a red cross to install its JDBC data access driver.
The right pane displays a link to the website for the database vendor.

3. Click the link.
The web page listing the JDBC data access drivers for the vendor appears. Depending on the
database, different types of driver files are available; usually a compressed file containing the drivers,
or an executable file to install the drivers automatically. For SAP Visual Intelligence you download
only the compressed file.

4. Download the compressed JDBC driver file, for example a .TAR.GZ, or .ZIP that contains the drivers
for your database middleware version. Use the following information to help you select the correct
driver:

To obtain the driverDatabase Middleware

Go to the Oracle JDBC Driver Downloads page: http://www.ora
cle.com/technetwork/database/features/jdbc/index-091264.html

Note:
To download the drivers, you must create an user account. This is free.

If you do not know which version of the driver to use, the driver ojd
bc6.jar is suitable for any supported version of Oracle 10 and 11.

Oracle

• Go to the SQL Server 2005, 2008 and 2012Microsoft Drivers download
center page: http://www.microsoft.com/en-us/download/driver.as
px?q=driver

• Click a suitable driver for your database. If you don't know which ver
sion of the driver to use, the Microsoft JDBC Driver 4.0 for SQL Server
is suitable for all supported SQL server versions.

• Download an installer. If you are installing Microsoft JDBC Driver 4.0
for SQL Server, then the installer is sqljd
bc_4.0.2206.100_enu.exe for a Windows environment.

• Run the installer from your local drive. It prompts you for an extraction
path to uncompress the files. Enter a folder path to save the driver
files and unzip the file. Close the window when completed.

Note:
The driver file sqljdbc4.jar is uncompressed to the following direc
tory within the specified extraction folder: \sqljdbc_4.0\enu\

MS SQL Server
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To obtain the driverDatabase Middleware

• Go to the Teradata connectivity download page: http://downloads.ter
adata.com/download/connectivity/jdbc-driver.

Note:
To download the drivers, you must create an user account. This is
free.

• Click a suitable driver for your database. If you do not know which
version of the driver to use, the Teradata JDBC Driver 14 is suitable
for all supported Teradata versions. ForWindows use: TeraJDBC__in
dep_indep.14.00.00.14.zip

• Download the compressed file and extract the two jar files inside
tdgssconfig.jar and terajdbc4.jar to a local directory.

Teradata

The Sybase driver is provided and installed by default. You should not
need to install this file. For information, the jconn4.jar driver is located
here in your installation: \\<Install dir>\Program Files\SAP
Visual Intelligence\Desktop\plugins\com.businessob
jects.connectionserver.standalone_3.1.3.v20120603-
0404\ConnectionServer\jdbc\drivers\IQ15

Sybase

• Go to the IBM DB2 connectivity download page:
https://www.ibm.com/account/profile/us?page=reghelpdesk.

Note:
To download the drivers, you must register using an IBM recognized
user email as your account name. This is free.

• Click a suitable driver for your database version. If you do not know
which version of the driver to use, both drivers for DB2 Version 10.1:
DB2 V10.1 FP0 (GA) or V10 should be suitable for all versions higher
than DB2 Version 9.5. If you are not certain, contact your database
administrator.

• Download the compressed file and extract the jar file db2jcc.jar
to a local directory. For versions prior to Version 9.5, you need to ex
tract db2cc.jar and db2jcc_license_cu.jar .

IBM DB2

5. From your local drive, browse to the folder that contains the extracted JDBC driver files for your
database middleware. Depending on your database middleware, you browse to one of the following
files:
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Driver
Database middle-
ware

ojdbc6.jarOracle

sqljdbc4.jarMS SQL Server

terajdbc4.jar and tdgssconfig.jarTeradata

jconn4.jarSybase

db2jcc.jar or for versions prior to 9.5: db2cc.jar and db2jcc_li
cense_cu.jar

IBM DB2

6. Restart SAP Visual Intelligence.
When you start SAP Visual Intelligence and create a new document using freehand SQL, the target
database middleware is listed with a green check indicating that the driver is available to access the
database. If you do not restart SAP Visual Intelligence, the available drivers list is not updated.

Related Topics
• Connecting to a Freehand SQL data source
• Specifying Freehand SQL connection properties

6.4.2 Connecting to a Freehand SQL data source

You need to install a JDBC data access driver for your database middleware before using Freehand
SQL. The data access driver is a .JAR file that you download from a database vendor site and copy to
the driver folder in the SAP Visual Intelligence installation path. Refer to Related Topics for information
on finding and installing the correct data access driver for your database middleware.

You can connect directly to a database to specify the data to be acquired and set parameters to optimize
the database connection.
1. From the Welcome screen, click New Document.
2. Click Free hand SQL.

A list of database middleware appears. If the middleware for the database that you want to access
using Freehand SQL appears with a red cross, then the driver is not installed for that middleware,
and youmust install the appropriate driver, see Related Topics for information on finding and installing
the data access driver. If your middleware has a green check, then you can start using Freehand
SQL.

3. Click the database middleware name for your target database.
• If the driver is available then Login and Advanced tabs for the driver appear in the left pane.
• if the driver is not available, click the Show Preferences button in the right panel to install the

data access driver.
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4. Enter login information in the Login tab, and if necessary specify the driver parameters on the
Advanced tab. These parameters are described in Related topics.

5. Click Acquire .
The free hand SQL editor opens.

6. Enter the SQL to fetch the required tables, preview the SQL query, and click Acquire .
The data appears in the Data pane.

Related Topics
• Specifying Freehand SQL connection properties
• Using the SQL editor for Freehand SQL
• Installing data access drivers

6.4.2.1 Using the SQL editor for Freehand SQL

You use an SQL editor to write SQL to create a Freehand SQL data source based on a connected
database. The SQL editor is accessed from the Freehand SQL connection option when you create a
new document.

Note:
Only the SELECT statement is authorized in the SQL editor to acquire data from database tables.

The SQL editor has the following options to help you select tables for your datasource:

DescriptionSQL editor options

The accounts available to the connected database. Expand each node to see
the tables available. Double click a table to enter the table in the SQL query.Catalog

The Select query to fetch the tables. Only SELECT is supported. You can add
table names by double clicking the table in the account node in the left pane.Query

Keeps a log of the Select statements used in the query pane. Click a statement
to include it in the query.SQL History

Click to preview the tables that are acquired by the SELECT.Preview data

You can select all the columns or no columns. You can select individual columns
for acquisition.Select All/None

Related Topics
• Connecting to a Freehand SQL data source
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6.4.3 Specifying Freehand SQL connection properties

You can create your own data provider by manually entering the SQL for a target data source to acquire
table data. When you use freehand SQL you must enter connection information for the target database,
and you can also specify connection parameters to optimize the fetching of data. You have the following
login and optimization options:

Table 6-5: Login parameters

DescriptionOption

User name

Password

The name and port of the server hosting the databaseServer <(host>:<port>)

Database nameDatabase

Table 6-6: Advanced parameters

DescriptionOption

If using a connection pool, the method to use to keep the Connection
Pool Mode connection active.Connection pool mode

If the Connection Pool Mode is set to Keep the connection active for,
the length of time in minutes to keep the connection open.Pool timeout

The maximum number of rows authorized with each fetch from the
database. For example, if you enter 20, and your query returns 100
rows, the connection retrieves the data in 5 fetches of 20 rows each. To
deactivate array fetch, enter an Array Fetch Size of 1. The Data is re-
trieved row by row.

Note:
Deactivating array fetch size can increase the efficiency of retrieving
your data, but slows server performance. The greater the value in the
Array Fetch Size, the faster your rows are retrieved. You must, however,
ensure you have adequate client system memory.

Array fetch size
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DescriptionOption

Size of the bind array before it is transmitted to the database. Generally,
the larger the bind array, the more rows (n) can be loaded in one opera-
tion and the better your performance.

Array bind size

The number of minutes before a connection attempt times Login Timeout
out and an error message is displayed.Login timeout

Values for JDBC driver properties. You can define the value of more
than one property, separated by commas. For example, the following
value for JDBC Driver Properties sets the oracle.jdbc.defaultNChar and
defaultNChar driver properties:

oracle.jdbc.defaultNChar=true,defaultNChar=true

JDBC driver properties

6.5 Working with SAP HANA views

SAPHANA is a database that contains data accessible as views. A view is a pre-defined virtual grouping
of table columns that allows you to access data that corresponds to a specific business requirement.
There are different types of views depending on the type of tables that are included, and the type of
calculations that are applied to columns; for example, an attribute view is built on dimension tables, an
analytic view is built on both a fact table and attribute views, and a calculation view executes a function
on columns when the view is accessed.

With this version of SAP Visual Intelligence you can create charts on data available as:
• Analytic views
• Calculation views
• Attribute views.

You can connect to views in two ways:

DescriptionConnect as to

Data can be manipulated and edited before being visualized in charts.SAP HANA cube

Data is read only and can be visualized in charts.SAP HANA cube online

Once you have connected to a view, the data is presented in columns, facets, measures, attributes,
and hierarchies.
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Once you have identified the measures and attributes to analyze, you build a chart by moving attributes
onto a visualization space, where they are automatically graphed on a chart. You can choose from a
large range of charts, depending on the type of visualization required for your business purpose.

When you have completed the chart, you can save it in a document. The chart can individually be sent
out by mail to your collaborators.

The data definition and data in the document can be exported as a flat file, or published to SAP HANA.

Related Topics
• Connecting to an SAP HANA cube
• Connecting to an SAP HANA cube online

6.5.1 Connecting to an SAP HANA cube

You can manipulate data and create visualizations from an SAP HANA cube.
1. Start SAP Visual Intelligence and click New Document .

A connection box appears.

2. Click Hana Cube
3. Fill in the connection information. You need to see your SAP Hana administrator for the Hana server

name and port number, and your user name and password if necessary.
4. Click the Connect Hana Instance button.

The pane under the login box is populated with the SAP HANA views available to your account.

5. Expand a SAP HANA view and select the cube that contains your data.
6. Do one of the following:

• If you want to select the attributes and measures that are acquired, click Preview and select
data then Select.

• If you want to acquire all the data, select Acquire all
If you selected Preview and select data, a dialog box appears with a choice of attributes and
measures. If you selected Acquire all the data opens in the Data pane.

7. Select attributes and measures to acquire and click Acquire .
The data appears in the Data pane.

Related Topics
• Working with SAP HANA views
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6.5.2 Connecting to an SAP HANA cube online

You can view data and create visualizations from a SAP HANA cube online.

Note:
When using a SAP HANA online data source, it is not possible to create a measure with an numeric
or string attribute. Measures in SAP HANA online are detected directly from the SAP HANA Analytic
view. Measures need to be created in the SAP HANA view, before being acquired automatically in
SAP Visual Intelligence.

1. Start SAP Visual Intelligence and click New Document .
A connection box appears.

2. Click Hana Cube Online
3. Fill in the connection information. You need to see your SAP Hana administrator for the Hana server

name and port number, and your user name and password if necessary.
4. Click the Connect Hana Instance button.

The pane under the login box is populated with the SAP HANA views available to your account.

5. Expand a SAP HANA view and select the cube that contains your data.
6. Do one of the following:

• If you want to select the attributes and measures that are acquired, click Preview and select
data then Select.

• If you want to acquire all the data, select Connect
If you selected Preview and select data, a dialog box appears with a choice of attributes and
measures. If you selected Connect the data opens in the Data pane.

7. Select attributes and measures to acquire and click OK .
The data appears in the Data pane.

6.6 Connecting to an Excel file

You choose an Excel spreadsheet as your data source.

Note:
If your Excel data contains cells that have been inserted into a column, then shifted up or down, this
data may not be correctly displayed when acquired. It is recommended that you remove the shifted
cells before acquisition for this version.

You have the following options to configure the data sheet before acquisition:
• Set first row as column names
• Show hidden columns
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• Show hidden rows

Note:
The maximum number of cells that can be acquired is 15 million. Spreadsheets with more than this
maximum are cut off at this point.

1. Click New Document from the Welcome page.
2. Click MS Excel.
3. In the Data source creation box do the following:

a. Browse to the Excel file.
b. Select the sheet that contains your data.
c. If required, show or hide hidden rows and columns.

4. Click OK.
The data appears in the Data pane.

6.7 Working with data from a universe

You can acquire data from a universe and visualize data using a wide palette of graphical charts and
tables of SAP Visual Intelligence. In this release, you can acquire data only from BI 4.0 Unv files and
BI 4.0 Unx files connected to relational databases.

Note:

Acquiring data from the following types of universes is not supported:
• Universes that exists on the XI 3.x platform
• BI 4.0 Unx file connected to an OLAP data source
• Universes connected to the SAP BW data source

6.7.1 Connecting to a universe datasource

1. Start SAP Visual Intelligence.
2. From the "Welcome" screen, choose New Document.
3. Choose Universe.
4. In the "Universe Credentials" pane, enter the following details:

a. Enter the name or IP address of the server hosting your Central Management Server (CMS).

Note:
If you are connecting to a CMS belonging to a different network domain, you need to ensure that
the hosts file located in C:\Windows\System32\drivers\etc has the corresponding host
name entry. For example, x.x.x.x <name of the machine hosting your CMS>
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b. Enter the CMS user name.
c. Enter the CMS password.
d. Enter the CMS authentication type.

Note:
To use the Windows AD authentication mode to connect to the CMS, append the following two
entries in the SAPVisualIntelligence.ini file located at: <VI_Install_Dir>\SAPVisu
alIntelligence\Desktop

-Djava.security.auth.login.config=<Path_to_bscLogin>\bscLogin.conf
-Djava.security.krb5.conf=<Path_to_kbr5>\krb5.ini

For example,

-Djava.security.auth.login.config=C:\Windows\bscLogin.conf
-Djava.security.krb5.conf=C:\Windows\krb5.ini

e. Choose Connect.
The list of universes available in the CMS are displayed.

5. Select the required universe and choose Select.
The universe tree appears with the list of data source classes and data source objects.

6. From the Universe Tree pane, select the required objects and choose Acquire.

Before acquiring data, you can preview the data and apply filters by selecting the Preview and
Select Data option.

Note:

• If the query contains contexts or prompts, you need to answer them to acquire the data.
• While creating a query, you can set the following query properties:

• Max Rows Retrieved: The maximum of rows to be retrieved by the query.
• Max Retrieval Time: The maximum amount of time a query can run. You need to enter the

time in seconds.
• Retrieve Duplicate Rows: Select this option to retrieve duplicate rows.

The data appears in the Data pane.

6.7.2 Troubleshooting Tips

This section describes error messages that you might encounter while working with the universe data
source and their probable causes.
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Causes
I am getting the following error while acquiring
data from the universe data source

This error might occur in the following scenarios:
• CMS is down.
• User name or password is incorrect.
• Authentication type is incorrect.
• Network issue.

Could not connect to Central Management
Server (CMS)

This error might occur in the following scenarios:
• Universe is corrupted.
• CMS is down.
• Universe connection is not configured properly.

Could not load the selected universe

This error might occur in the following scenarios:
• Issue with the database connection.
• Mismatch of data types for the selected object.
• Result returned from the server reached the limit

set for the configuration parameter Maximum
Character Stream Size (MB) of Web Intelligence
Report Server.

• Universe object(s) not configured properly.

Could not validate the query

Selected object(s) results in a query which returns
empty data.

Query returns no rowsets
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Using SAP Visual Intelligence

7.1 Basic operations

When you start SAP Visual Intelligence the Home page contains information that helps you to get started
building a new document, opening existing documents, and managing your documents within the
application. There are also links to useful resources that you can use to develop your chart building
skills and knowledge.

Before you get started, this section covers some application basics:
• How to start building a new document
• Opening an existing document.
• Saving your new or modified documents
• Opening a dataset to create a chart.
• Using the two working modes: Prepare and Share.

Related Topics
• Creating a new document
• Opening documents
• Opening datasets
• Saving your charts
• Saving your documents
• Prepare and Share working modes

7.1.1 Prepare and Share working modes

SAP Visual Intelligence has two working modes that are accessible by clicking the buttons at the top
of the application window.

DescriptionWorking mode

Your workspace where you analyze your dataset and build your charts.Prepare panel
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DescriptionWorking mode

The sharing area where your saved datasets and charts are listed. You can send
charts by email from the panel. You can not send datasets by mail.

Note:
When using the Share panel, you must ensure that no dataset is also selected
when you select a visual. If this is the case, the Send by Mail button will not be
active. Unselect the dataset by clicking it to reactivate the Send by mail button.
You can then select a visual to send.

Share panel

7.1.2 Creating a new document

A document is your starting point when using SAP Visual Intelligence. You create a new document to
start analyzing your data and building new charts. You can open stored locally saved documents to
view or modify existing charts and datasets.

Each document is a file that contains:
• Connection parameters for the data source if the source is an RDBMS.
• Dataset: The column data used to create charts.
• Charts built on the data and saved as visuals.
1. From the Home page, click the New Document button in the top left corner of the Home page.
2. Connect to or browse to your data source.
3. Click Acquire or Select as required.

The columns appear in the Data Pane, the attributes and measures to the left in the Semantic pane.
You are now ready to start building a chart with the data.

7.1.3 Opening documents

You open documents from the Home page.
1. From the Home page, click the Documents tab to the left of the page

A list of available documents appears.

2. Double click a document.
If a data source is required, a connection box appears. Fill in the login credentials if necessary and
click OK .

2012-10-2238

Using SAP Visual Intelligence



3. The document opens. The columns can be viewed in the Data pane and the visualizations that have
been saved with the data are available in a preview panel at the bottom of the Visualization pane.

7.1.4 Saving your charts

You save a chart from the Visualization pane. Each chart saved on the active dataset appears as a
preview icon in the panel at the bottom of the Visualization pane.

The documents and their saved visuals are saved to the SAP Visual Intelligence application Documents
folder in in your profile path.
1. Create or modify a chart in the Visualization pane.
2. Click the Save button at the bottom right of the pane.

An icon for the saved chart appears in the panel at the bottom of the Visualization pane.

7.1.5 Saving your documents

When you save a document, you save the dataset and the charts that have been saved individually in
the Visualization pane.

Note:
To save your charts with the dataset, you must firstly save each individual chart from the Visualization
pane. If you save a document without previously saving the individual charts built on the dataset, only
the dataset is saved.

1. Ensure that you have saved any charts built on the dataset.
2. Select File > Save.

The document is saved including the dataset and its visuals.

7.1.6 Opening datasets

A dataset is the set of columns, hierarchies, and filters used to build a document. It does not contain
any charts build using the data. Datasets are stored in the SAP Visual Intelligence application Documents
folder in in your profile path.
1. From the Home page, click the Datasets tab to the left of the Home page.
2. A list of available datasets appears.
3. Double click a dataset.
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A connection box appears.

4. Fill in the credentials if necessary and click OK.
The dataset opens in the Data pane.

7.1.7 Importing a document to the Documents folder in Visual Intelligence

You have SAP Visual Intelligence open, and you want to import an SViD file to the Documents folder.
The Documents panel corresponds to C/Users/<Your username>/My Documents/SAP Visual
Intelligence Documents. You can import a file into this destination so that the file is visible in SAP
Visual Intelligence.
1. In SAP Visual Intelligence Select File > Import to Folder.
2. In the "Import" pane, navigate to the file you want to import.
3. Select the file and click Import

The file is imported into the SAP Visual Intelligence"Documents" tab. A confirmation message
displays, you can choose to open the file if you wish. Click Yes to open the file, or clickNo to continue
without opening the file.

The imported file is visible in the "Documents" tab.

7.2 Finding your way around the user interface

When you open a document there are three panes available to visualize your data:

DescriptionExplorer Desk-
top

Click the Data button to activate.

Your data is displayed as columns in Grid view, or as facets in facet view. When
using facets, the data still appears in columns but only unique values are displayed,
so the repeated values are not shown. You use the data pane to:
• View data
• Hide columns
• Filter and sort the values in the column

Data pane

Shown to the left of the Data pane. Your measures, hierarchies, attributes and in-
ferred attributes are listed here.

Semantic
pane
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DescriptionExplorer Desk-
top

Click the Visualize button to activate.

It is viewable as a single pane, or with the Data pane when using Split mode. You
create your charts here. The Visualization pane includes a collapsible side panel
called the Chart feeder. You can use this panel to build the charts in a structured
way.

Visualization
pane

The Semantic and Visualization panes are described in more detail in Related Topics.

Related Topics
• The Data pane
• The Semantic pane
• The Visualization pane

7.2.1 The Data pane

The data pane is the central pane that shows your data. You use the Data pane to view, organize, and
clean the data. You can view data in two ways:

DescriptionVisualizing
data as

Data is presented as columns and rows. All rows are displayed.Grid

Data is presented as columns with only the unique values shown. The repeated
values in columns are not shown. Using facets can be useful if you have many re-
peated values.

Facets

You have the following data manipulation and formatting tools to help you manage and edit your data
set:

DescriptionData management tools

You can acquire data from one or more different data sources to be
available within the same session. This is useful when you want to com-
pare different datasets before merging columns.

Add

You can merge data from multiple datasets into the current dataset. The
data needs to be compatible.Merge
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DescriptionData management tools

You can switch from one dataset to anotherData switcher

An editing tool that allows you to edit and format values both at a column
and row level.Data manipulation

You can define constraints to filter column data.Data filters

You can create formulas using an editor and formula language defined
for SAP Visual Intelligence .

Formula creation and
edition

Related Topics
• Editing and cleaning data
• Adding another data set
• Merging another dataset
• Switching to another data set

7.2.2 The Semantic pane

The Semantic pane is displayed to the left of the central Visualisation pane. It lists the measures,
hierarchies, inferred attributes, and attributes in the dataset:

DescriptionSemantic pane ob-
jects

Maps to aggregated data in a column or calculation. You use measures to get
the calculated result when different columns are combined. For example a
measure called Sales Revenue would represent the column Sales Revenue
that contains the summed revenue for sales. Measures are automatically de-
tected and listed.

Measure

References more than one related column in your dataset. These columns
have hierarchical relationships, for example an object Time, could inlcude
Year, Quarter, and Month arranged in a hierarchical structure under the top
object Time.

Hierarchies

Map to columns in the dataset.Atttributes
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DescriptionSemantic pane ob-
jects

One or more columns that are created based on geography or time data
available to SAP Visual Intelligence to support a hierarchy. For example, if
you select Create a Geographic hierarchy for the attribute City, you can
select the levels of the hierarchy (Country, Region, City). SAP Visual Intelli-
gence infers the Country and Region from a geography database, and Country
and Region columns are created matching the City values. These columns
are added to the dataset, but are not part of the original dataset. They are in-
ferred and added to support the hierarchy.

Inferred attributes

7.2.3 The Visualization pane

The Visualization pane is the central pane where you build your charts and graphs to visualize your
data. The Visualization pane can be used either as a full pane replacing the view of the Data pane, or
in split view, retaining the view of the data and allowing you to build visualizations below while always
keeping the data visible. The Visualization pane has the following components:

DescriptionVisualization pane
components

Icons displayed at the top of the Visualization pane. Each icon represents
a chart or graph family that you can use to visualize your data. Click the
arrow next to each icon to see the different chart and graph variations for
each family.

Chart switcher

This is a side panel that is activated by clicking the arrow on the left border
of the Visualization pane. The Chart feeder contains the fields that are used
for the X (category) and Y (measure) axis in your charts. You build a chart
by either double clicking or dragging an object to the appropriate field in
the Chart feeder. Usually a measure is used for the Y axis and a category
object is used for the X axis.

Chart feeder

The area used to build your chart. The type of chart selected in the Chart
switcher is shown initially to guide your placement of objects on the chart.
You can build a chart either by dragging objects directly to the Chart body,
or to the Chart feeder.

Chart body

Related Topics
• Visualizing your data
• Choosing a chart type for your data
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7.3 Filtering data in columns and charts

A filter is a restriction imposed on a data set to limit the values displayed. For example, if your chart
shows revenue for products sold over years between 1995 and 2012, and you only want to see revenue
for the years 2010 to 2012, you create a filter on the dimension Year to limit the values shown to this
period.

Each filter created in a column appears as entries in a Global filters bar. Edit directly from the filter bar.

You can define the following typs of filters:

DescriptionFilter scope

You define a filter on a column that applies to both the data and the
charts that use the column data.Data set filter

You define a filter on a chart that only applies to the chart. The filter
is not applied to the data at the dataset level.Visualization level filter

Note:
You can apply filters globally by selecting the Use global filters checkbox. When selected, all filters
defined on the columns apply automatically to the charts created with the column data.

Related Topics
• Filtering data in columns and facets
• Filtering data in charts
• Using the filter panel

7.3.1 Filtering data in columns and facets

You can create a filter on a column or facet from the column header. The filter defined on a column
applies to both the values in the column and the charts that use the column data.
1. Click the Data or Split buttons to display the columns for your data source.
2. Click the filter icon in the column header.

The "Filter" panel appears. It contains the options available to define the filter.

3. Define the filter in the "Filter" panel. Using the "Filter" panel is described in Related Topics.

2012-10-2244

Using SAP Visual Intelligence



Related Topics
• Using the filter panel

7.3.2 Filtering data in charts

If you are in Visualize mode, you can create filters directly on the data in a chart using the Chart feeder:

Note:
A filter defined on a chart, only applies to the chart.

1. Activate the Chart feeder panel
2. Drag an attribute to the Filter section. This is the attribute that you want to filter on.
3. Click the arrow to the right of the attribute name.
4. Define the filter in the Filter panel. Using the Filter panel is described in Related Topics.

Related Topics
• Using the filter panel

7.3.3 Using the filter panel

You define a filter using the filter panel. You access the filter panel from the drop down menu for a
column header, or from the Filter category in the Chart feeder panel.

Note:
A filter defined on a chart, only applies to the chart.

1. Open the filter panel as follows:
• Click the filter icon in a column header.
• Open the Chart feeder and drag an attribute to the Filter category.
The filter panel appears. You have the following filter options for text based data:

DescriptionFilter options

Type one or more characters of a column value to search and dis-
play the value.Search field

All unique values for the column are listed with the number of oc-
curences for each value.All values
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DescriptionFilter options

Click the appropriate button to add a value to filter, remove a value
from the filter, or remove all values from the Filtered values list.Add, Remove, Remove All

Selected values to filter.Filtered values

Select to retain only the values in the Filtered values pane in the
column. All other values in the column do not appear in the column
or dimension.

Keep only

Select to include all values in the column or dimension except the
values in the Filtered values pane. You define a filter to exclude
values not to include.

Exclude values

2. Select the options required for your filter based on the descriptions in the previous table.
Click Close.
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Working with SAP Visual Intelligence

8.1 Preparing your data

The data in the Data pane is raw data so it is not often formatted consistently, and is not easily interpreted
by business users. Before creating the charts to visualize your data, it is often necessary to clean up
the data so it is presentable and understandable.

Cleaning data can be done in Grid or Facet mode. You use an edit panel indicated by theManipulation
tools button at the top of the Data pane to do column management tasks, for example; column
duplication, splitting, renaming, and removal. You can also carry out row level editing tasks, for example;
setting values to lowercase, find and replace, adding or trimming text, and adding formulas.

Editing tasks can be applied to all values in a column or to selected values.

Related Topics
• Editing and cleaning data
• Formatting numbers and dates
• Creating hierarchies
• Creating measures
• Adding another data set
• Switching to another data set
• Merging another dataset

8.1.1 Editing and cleaning data

You use an editing panel to the right of the central pane to edit and format the values in a column. The
editor is indicated by the vertical sidebar Manipulation tools to the right of the central pane. You can
use the editor in either Grid or Facet view.
1. Do one of the following:
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Do this...To edit ...

Click the column header.all values in a single column.

Click CTRL and click individual column headers.all values in multiple columns

Click an individual cellindividual value.

Press CTRL and click individual cellsmultiple values in a column.

Double click in Grid or slow double click in Facet view
and select a range of characters or a word.

Note:
Only available for character values.

a range of characters or a word within a
cell (cell inner selection).

2. Click the vertical sidebar Manipulation tools at the top right of the central pane.
The editor panel opens. The unique column values appear in an All values box at the top of the
panel. You can select one or more values to edit in this box, or enter a search string in the Filter
items box. Selections in the editor panel over-ride the value selections made directly in the column.
Column editing options depend on the data type of the column, and whether a column, a cell, or a
range of characters within a cell are selected. You have the following options:

Use for
Number

Use for
Date

Use for
CharacterDescriptionEdit tool

YesYesYesCreate new column that is a duplicate of the se-
lected column.

Dupli
cate

YesYesYesChange the column name.Re
name

YesYesYesRemoves selected column.Re
move

NoNoYes

Creates a new column with string values appear-
ing after a defined split point. The split can be a
punctuation mark, for example a comma, or a
text string.

Split

YesYesNo

Create a new column for number and date types
that applies a function to values, for example a
function Floor can be applied to a columnMargin
to create a new column of margin values rounded
down to the nearest whole number.

Create

NoNoYesChanges string values to either lower or upper
case.

Set
case

NoNoYesSearch to find a string and replace with a new
string.

Find
and re-
place
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Use for
Number

Use for
Date

Use for
CharacterDescriptionEdit tool

NoNoYesSpecify a character to prefix or suffix a string to
a defined character length.Fill with

NoNoYesRemove characters after or before a specified
punctuation mark or a character.Trim

YesYesYes

Create a new column where you can create new
groups of rows (for example group 1, group 2...)
to organize your rows. Rows that are not in spe-
cific groups can be organized in a group called
'Others' or can remain individual.

Group
ing

NoNoYes

When you double click in Grid or slow double
click in Facet view and select a range of charac-
ters or a word, you can do the following: opens
remove, replace, create columnwith same values
but cleaned (example remove "resort" from val-
ues.

Cell in-
ner se-
lection

3. Click an editing option in the right pane. Select or type the modification to the values and click Do
it .
The change is effected immediately in the affected or new column.

8.1.2 Formatting numbers and dates

You can choose a display format for columns with number and date type.
1. Click the down arrow head in the column header of a numeric or date column.
2. Select Display format from the drop down menu.

A display definition box appears. You have the following options:

DescriptionDisplay option

Decimal point separator.Use scientific number
format

Comma separator.Use 1000 separator

Specify the number of decimal places for the column values.Number of decimals

Select a date format.Date display formats (
Date type only)
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3. Select the required options and click OK.

8.1.3 Enriching your data automatically

Using measures and hierarchies makes charting easier; measures allow easy manipulation of
calculations, and hierarchies allow you to use a natural grouping of related columns. You can create
measures and hierarchies manually, or let SAP Visual Intelligence detect columns that are potential
measures, as well as time and geography hierarchies when you acquire data. This section describes
how you can let SAP Visual Intelligence create measures and hierarchies automatically.

If SAP Visual Intelligence detects measures and hierarchies in your data, a semantic enrichment box
at the bottom of the semantic pane indicates how many elements have been detected.
1. Click Show if your data contains detected semantic elements.

The detection visualization box appears. It lists the columns that have been detected as being
candidates for measures and hierarchies.

Note:
If you want to accept all the measures and hierarchies detected, then click Enrich All directly.

2. You can do one of the following:
• If you do not want one or more of the columns to be used as a measure or in a hierarchy in the

current dataset, but want the detection to stay available for a later use, clear the column check
box and click Close .

• If you do not want to use a detection at any time, click the column Remove button to ensure
that SAP Visual Intelligence does not continue to propose it.

• Select or clear the columns that you want to be accepted as measures of hierarchies and click
Enrich

The new measures and hierarchies appear in the Semantic pane.

Related Topics
• Creating measures
• Creating hierarchies

8.1.4 Creating hierarchies

You can create Time and Geography hierarchies to enrich your dataset. Time and geography hierarchies
are detected automatically by when a dataset is acquired. However, you can also manually create
hierarchies at any time.
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Note:
Time hierarchies can be created on numeric and date type columns. Geography hierarchies can only
be created on columns containing values compatible with geography data values in the NAVTEQ
database used by SAP Visual Intelligence .

You create hierarchies from the contextual menu indicated by the down arrow head of either :
• the column header
• the attribute.
1. Click the down arrow head on the header of a column or an attribute, that you want to use as the

basis for a hierarchy.
2. Select either Create a Geographic hierarchy or Create a Time hierarchy from the drop down

menu.
Depending on what type of hierarchy you want to create, you have the following column or attribute
enrichment options:

DescriptionHierarchy option

Select the levels of the time hierarchy. You select the columns to be
mapped for Day , Month , and Year levels.Time

Select the levels of the geography hierarchy. You can select the columns
to be mapped for some or all of the Country, Region , Sub-Region , and
City levels. These columns are checked for matches with the internal
geography database used by SAP Visual Intelligence.

Geography

Columns detected as possible matches are listed in the level drop down
lists. if no columns are detected, then the lists are empty. You need to
select the All columns button to allow a choice of all columns for the levels.

Detected columns

All columns are displayed in the level drop down lists.All columns

3. Select the columns to be matched to hierarchy levels and click OK.
Depending on the type of hierarchy you are creating, you have the following result:

ResultHierarchy type

The new time columns selected as levels are automatically added to the
dataset, and the new time hierarchy appears in the Hierarchies semantic tab.Time

A geographical location resolution box appears. The columns that are matched
with the internal database are indicated in green, the ambiguous matches in
orange, and the non matches in red.

Geography

Columns created for the hierarchies.Inferred attributes
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4. For the proposed Geography matches, you can accept or modify the choices proposed for the
matched and ambiguous locations. To select another location choice, click the proposition row and
select one of the following:
• Choose: Select to accept the location proposition.
• Not found: Remove this from the proposition choices.

5. Click OK.
The new geography columns selected as levels are automatically added to the dataset, and the new
geography hierarchy appears in the Hierarchies semantic tab.

Note:
The new columns are added to both the dataset and the Inferred Attributes Semantic tab.

8.1.4.1 Creating a geography hierarchy with latitude and longitude data

If your dataset contains latitude and longitude data, you can customize a geography hierarchy to use
this data. The latitude and longitude data must be numeric. If this is not the case, you convert the column
values using a conversion formula, for example ToNumber(). If your latitude and longitude columns are
numeric, SAP Visual Intelligence creates a measure for each column at data acquisition.

Note:
If your columns are not numeric, you need to define the numeric converted attributes as measures
manually.

SAP Visual Intelligence automatically calculates hierarchical levels above and below the selected
geographic attribute. You can accept these calculated levels in your hierarchy, or replace them with
user defined levels based on the latitude and longitude data.
1. Verify that measures have been created for your latitude and longitude columns:

• If Yes, then go to the next step.
• If No, then do the following:

DescriptionDo this

Click the latitude attribute or column and click Manipu-
lation Tools. In the Formula bar, type ToNumber(lat
itude) and clickDo It. Repeat for the longitude attribute
or column. Ensure you type longitude as the variable.

Convert the latitude and longitude
columns to numeric data type.

Click the arrowhead by the new numeric latitude attribute
and select Create a measure. Do the same for the new
longitude attribute.

Define the new numeric latitude and
longitude attributes as Measures.

2. Click the down arrow head on the header of a geography column or attribute that you want to use
as the basis for a hierarchy.

3. Select Create a Geographic hierarchy > By Latitude/Longitude .
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A geographic enrichment box appears. The Level Name pane to the right of the box lists the
hierarchy levels calculated by SAP Visual Intelligence . The original attribute is shown in red, and
the other calculated hierarchy levels in green. You can accept this proposed hierarchy based on the
latitude/longitude data, or you can customize the levels. The properties for each level are shown in
the left side pane. Click a level to see its properties in the left pane. You have the following properties:

DescriptionLevel property

The definition for the level. It is either calculated based on the latitude/longitude
data, or it can be user defined where you select the column that the level is
based on.

Category

Available for user defined levels. You select a column for the hierarchy level.Column

Available for user defined levels. You select the latitude data to use for the
level.

Latitude

Available for user defined levels. You select the longitude data to use for the
level.

Longitude

The name of the level in the hierarchy.Level type

4. You can do one of the following:
• If you want to accept the proposed calculated levels, click OK .
• if you want to customize the proposed levels, go to the next step.

5. Click a level, then do the following:
a. Select User Defined from the Category drop down list, then select the properties for the level

from the other drop down lists.
b. Click the up/down arrowheads to the left of each level to move levels up or down the hierarchy

as required.

Note:
You can remove a level by clicking the X icon to the left of the level.

c. If required, click Add Level to add a new level to the hierarchy. This level is user defined.
d. Repeat these steps for each user defined level in the hierarchy.

6. Click OK .
The new geography hierarchy is added to the Hierarchies category in the semantic pane.

Related Topics
• Creating hierarchies
• Customizing columns with formulas

8.1.5 Creating measures
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You can create measures to enrich your dataset. Measures are detected automatically on numeric
column data types when a dataset is acquired. However, you can also manually create measures at
any time.

Note:
When using a SAP HANA online data source, it is not possible to create a measure with an numeric
or string attribute. Measures in SAP HANA online are detected directly from the SAP HANA Analytic
view. Measures need to be created in the SAP HANA view, before being acquired automatically in
SAP Visual Intelligence.

You can create a measure from any column or attribute with the following constraints:
• If column data type is Numeric, any aggregate function can be used for the measure.
• If column data type is Date or String, then Sum or Average can't be used.
• Aggregation is performed in when the measure is used in Visualization and Facets views. It is not

available in the Grid view.

You create measures from the contextual menu indicated by the down arrow head of either :
• the column header
• the attribute.
1. Click the down arrow head on the header of a column or an attribute that you want to use as the

basis for a measure.
2. Select Create a measure from the drop down menu.

A new measure is created in the Measures tab of the Semantic pane.

3. Click the new measure and select an aggregation function from the drop down menu.
4. To see the measure applied to the data in the dataset, click the Facet button to enter facet view.

The measures are listed in the occurrence pane to the left of the facets.

5. Click a measure to see the data values change affected by the aggregation.

8.1.6 Customizing columns with formulas

You can create and apply formulas to column values using the SAP Visual Intelligence formula language.
The formula editor appears at the top of the Data pane when you click Manipulation tools. When you
create a formula on a column, a new column is created with the values affected by the formula.

Note:
Each function available in the formula language has an associated description of its syntax.

You have the following features are supported in the formula editor:
• Combine any two columns in the data set.
• Apply functions from a pre-defined set of numeric, date and text functions. Functions are also

accompanied by a description of the syntax.
• Use If...Then...Else clauses.
• Use Auto-completion to speed up editing.
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• Use a calendar picker for date parameters.
1. Click Manipulation tools.

The formula editor appears as a bar at the top of the Data pane.

2. Click the fx button.
A list of available functions appears.

3. Click a function.
The function appears in the editor text box.

Note:
Click the double arrow head button at the end of the formula bar to get Help associated with the
function. The Help describes the function and its syntax.

4. Type the parameters for the function and associated information based on the function task. You
must type the names of columns used in the formula. The auto-completion suggests the column
names after the first letter.

5. If you are inputting calendar information, click the Add date button to use the date picker.
6. Click Do it to apply the formula.

A new column is created with the values affected by the formula.

Example: Creating a formula

You want to create a formula that multiplies the values in the column margin_gross_percent by 100
and round it to the superior integer, you do as follows:

DescriptionStep

The formula editor appears at the top of the Data pane.Click Manipulation tools

Choose Ceil(num)Click fx

Ceil(margin_gross_percent )*100Type parameters

Column called Ceil(margin_gross_percent )*100.New column with default formula name
is created.

Right click the column header and select Rename .Change column name

8.1.7 Adding another data set

You can open multiple datasets in the same document.
1. Click the Add button in the top menu bar.

The Select a Source box appears.
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2. Click a datasource in the New Data Source pane or a data source in the Recent Data sources
pane.

3. Enter the appropriate connection information and click Acquire .
The datasource is available by clicking the Dataset Switcher button. Refer to Related Topics for
more information on connecting to data sources.

Related Topics
• Acquiring data from your data sources

8.1.8 Switching to another data set

You can work with multiple datasets open in a document. You can switch from one dataset to another.
This is useful when preparing a merge between two datasets.
1. Click the Data switcher button in the top menu bar.
2. Click a dataset name from the drop down list.

The selected dataset is now the active dataset.

8.1.9 Merging another dataset

You can combine the data from two different datasets. The dataset columns for the second dataset are
matched based on compatibility with a key column. The matched columns are proposed with the
probability of the match. The following conditions are required before two datasets can be merged:
• The merging dataset must have a key column.
• Only columns with the same data type are considered.
• The merge adds all columns.
1. Click the Merge button in the menu bar.

The merge dataset box appears. The current dataset is shown in the Left pane.

2. Click the primary key column that you want to use as the identifying column to match columns for
a merge.

3. Do one of the following:
• If you already have the dataset to merge available in the document, select the dataset from the

drop down list above the right pane.
• If you do not have a dataset open, click the Add button and select a data source to merge.
The columns that can be matched based on the key column from the left dataset are listed in the
right pane.

4. Click Merge .
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• The columns are added to the original dataset.

8.2 Visualizing your data

There are two ways to visualize your data:

Note:
Chart titles are automatically generated based on the attributes and filters used to build the chart. You
can change these at any time.

DescriptionHow?Visualization
method

The Chart feeder panel provides a structured
method to build a chart. You can :
• Drag measures and objects to the indicated

categories.
• Sort, rank measures, define filters, add calcula-

tions.

• Activate the Chart feeder
panel

• Drag attributes and mea-
sures to the Chart feeder.

Using the Chart
feeder panel

The quickest way to create a chart. As you drag
objects to the chart body, the chart is automatically
built assigning the objects to the different axes.
Text instructions, and a ghost chart that serves as
a visual template for your chart, guide you through
the process.

Drag objects directly from the
Semantic pane to the chart
body part of the Visualization
pane.

Build directly on
the chart body

Note:
Visualizations are limited to 30,0000 data points with interactivity, and 100,000 with no interactivity, due
to screen size limitations and ability to visualize larger amounts of data. A warning appears when that
limit is exceeded and you are asked to filter the set.

Related Topics
• Building a chart using the Chart feeder panel
• Creating a chart directly in the Chart body zone
• Choosing a chart type for your data

8.2.1 Building a chart using the Chart feeder panel
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The Chart feeder panel guides you when building a chart. If the Chart feeder panel is not visible, you
activate it by clicking the small arrow to the left of the Visualization pane

Once activated, you drag measures and attributes to the indicated boxes and the chart automatically
builds with each object added.

You have the following categories and options available in the Chart feeder panel:

Option descriptionOptionsDescription
Chart
feeder
category

Click the down arrow next to the mea-
sure and select an ascending or de-
scending sort.

Sorting
• Measures are pre-defined in

the view and are listed in the
Measure tab of the Semantic
pane.

• Each chart must have at least
one measure.

• Depending on the type of
chart, if you have multiple
measures, the values are col-
or coded for each measure in
the chart key to the right of the
chart.

Mea
sures

Click the down arrow next to the mea-
sure and select a predefined calcula-
tion.

Adding a
calculation

Click the down arrow next to the mea-
sure and select either a top or bottom
ranking sort for a selected dimension
in the chart.

Ranking
values

Category• Multiple attributes can be
added to the Chart feeder.

• The attribute values show a
"dimension" of the data affect-
ed by the measure.

Dimen
sions Legend col-

or

Attributes can be added as rows
or columns.Trellis

You can filter the dimension ei-
ther on a single value of the di-
mension or choose multiple val-
ues.

Filter

1. If the Chart feeder panel is not visible, click the arrow to the left of the Visualization pane.
2. Drag and drop one or more measures to the Measure box in the Chart feeder. If required, click the

down arrow to the right of each measure to define a sort, calculation, or ranking.
3. Drag one or more attributes to the Dimension box. You have two ways to represent dimensions on

a chart:
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Do this...if you want

Drag a dimension to the Category
box.

dimension labels displayed as a grid under the X axis.

Drag a dimension onto the Legend
color box.

dimensions to be individually color coded and displayed
linearly on the X axis.

Note:
The previous options apply to bar charts, but for other charts the dimensions can be displayed
differently.

4. Drag a dimension onto the Filter section. Click the arrow to the right of the filter and select values
to filter on.

The chart is built automatically as you drag objects to the boxes in the Chart feeder panel.

8.2.2 Creating a chart directly in the Chart body zone

You can create a chart directly by dragging objects to the chart body. A chart must have at least one
measure. When you add an attribute to the chart, its values are calculated based on the measures,
and the attribute becomes graphically a " dimension" of the measure. This is why attributes are referred
to as dimensions in charts.

You can create a chart directly either in full visualization mode or in split mode.
1. Click one of the following:

• The Visualize button in the icon menu bar if you prefer to build a chart with objects.
• The Split button if you prefer to build a chart with columns or facets.

2. Select a chart type from the choice of charts in the chart menu bar. You can change the type of chart
at any time if you prefer another chart type for your visualization.

3. Click a measure and drag it to the side of the chart body. Text guides you to the correct axis to drop
the measure.

4. Click an attribute or a column header and drag it onto the chart. Depending on where you drop the
attribute or column header on the chart, the dimension can be plotted either:

Drop the attribute or column
header here...If you want the dimension...

On the X axisplotted as a single color, with multiple dimensions arranged
in a grid under the X axis.

In the middle of the chart body.plotted in color, with multiple dimensions grouped in color
blocks.

5. Add measures and dimensions as required.

2012-10-2259

Working with SAP Visual Intelligence



6. If you want to filter the data in the chart, do one of the following:

Do the following...Option

Go to Split mode and set the filter on the required column.Create the filter directly on a col-
umn

Open the Chart feeder panel and create the filter in the Filter
box.

Create the filter in the Chart feed-
er

The chart is updated automatically with the new filter.

Note:
For full information on creating filters, refer to the section in Related Topics.

The chart is built instantly as you drag objects onto the chart body.

Related Topics
• Filtering data in charts
• Choosing a chart type for your data

8.2.3 Choosing a chart type for your data

There are multiple families of chart types to choose from for your visualization. You can use charts from
different families to represent similar types of information, while giving a different look to the information.
Here is a guide to the type of charts you can consider based on the type of analysis shown in your
chart:

Available chartsDescriptionChart shows this type of
data analysis

• vertical bar chart
• horizontal bar chart
• bar chart with two y axes
• radar chart
• multiple radar chart
• surface chart
• tag cloud chart

You want to view the differences be-
tween values, or need to show the
simple comparison of categorical divi-
sions of measures.

For example, you could use a bar
chart to compare the differences in
your sales revenue between different
countries.

Comparison
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Available chartsDescriptionChart shows this type of
data analysis

• pie
• multiple pie chart
• vertical 100% stacked bar

chart
• horizontal 100% stacked

bar chart
• treemap

You want to show show the percent-
age of parts to a whole, or show val-
ues as ratios to a whole. The legend
shows the percentage and the total
values. The chart types available are:

For example, use a pie chart to see
who had the highest sales as part of
a total sales value directly:

Total sales = $200, Paul had 10%
($20), David had 65% ($130), and
Susan had 25% ($50).

Percentage

• scatter chart
• bubble chart

The size of bubbles within
the chart is determined by
a third measure.

You want to view the relationship be-
tween values, or to r compare multiple
measure values.

For example, you can view the corre-
lation of two measures, and under-
stand the impact of the first measure
on the second measure.

Correlation

• line chart
• line chart with two y axes
• Multi-bar chart
• Multi-line chart (multiple

measures)

You want to show a trend in the data
values, especially for dimensions that
are time based such as Year. You
may also want to see the progression
of your data and possible patterns.

For example, you can use a line chart
to view sales revenue trends of a
product throughout a range of years.

Trend

Country chart

You want to show a map of the coun-
try object used in the analysis. You
may also need to see the data for di-
mensions sorted by country shown on
the map, or want to see the geograph-
ical spread of data for any single
country.

Geographical
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8.2.4 Predicting data trends over time

You can use predictive calculation to add the following type of information to your charts:

DescriptionType of predictive analysis

Allows you to predict how data may behave in a defined future period.
Depending on the type of chart, the forecasted data is displayed as
bars or a line in a single color added to the existing chart plots for a
defined future time period.

Forecast

Allows you to see the how data is most probably distributed around
your actual data to give a generalized trend over time. Depending on
the type of chart, the regression is displayed as bars or a line superim-
posed over the existing chart plots.

Linear regression

The predictive calculation is available for a measure on the Y axis of a chart when charted with a time
based hierarchy on the X axis. It is not recommended to usemultiple measures whenmultiple dimensions
are also plotted as it becomes difficult to interpret the prediction.

Note:
The forecasting is based on the Triple Exponential Smoothing algorithm which predicts based on a
single fixed time period. You are prompted to choose the time period for the predictive analysis, so it
is recommended that you choose an aggregation that makes sense within a specific cycle. For example
if you choose an aggregation on month, this allows the analysis to be done over a year and abstract
weekly cycles.

For this release, predicative analysis is only available for bar and line charts.
1. Drag a measure onto the Y axis of a chart.
2. Drag a time based hierarchy or attribute onto the X axis of a chart.
3. Click the down arrowhead at the right side of the measure icon and select one of the followingfrom

the measure drop down list:
• Predictive calculation > Forecast
• Predictive calculation > Linear regression .
A period prediction box appears.

4. Select the number of time units that you want to specify for the predictive calculation from the periods
to predict drop down list. The time units are determined by the selected hierarchy level for the time
dimension.

5. Click OK .
The forecast or linear regression prediction is displayed superimposed on the chart data.
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8.2.5 Applying calculations, sorting, and ranking on measures

You can apply running total calculations, moving average, percentage, sorting, and ranking on the
measures in your chart.
1. Click the down arrowhead next to the gear wheel icon for a measure in the semantic pane.
2. Select one of the following sort, rank, or calculation options from the drop down list:

3rd level selection2nd level selectionSelect this option

Sort Ascending

Sort Descending

• Running_Sum
• Running_Min
• Running_Max
• Running_Count
• Running_Count_NE
• Running_Avg
• Running_ Avg_NEAdd Calculation

Select the number of values before
and after the measure value to use
for the moving average.

Moving_Avg

Percentage

Select top or bottom num-
ber of values to be shown
for a selected dimension.

Edit Ranked Value

Remove Ranked Value

The sort and running total calculations are immediately shown in the chart.

3. Click OK in the definition boxes to apply the moving average and rank calculations.

8.3 Sharing your charts and datasets

You can share charts created in SAP Visual Intelligence in two ways:
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DescriptionSharing method

You can automatically attach your chart to a mail
message and send it to collaborators.Sending your chart by mail

You can save your document (charts and data)
as a .SViD document.Saving your document on the file system .

You share your datasets as follows:

DescriptionSharing method

You can save a dataset as a C.S.V file or an MS Excel file.Export

You can publish a dataset to SAP Hana as a new analytic view.Publish to SAP HANA

You can publish a document to SAP Streamwork.Publish to Streamwork

Related Topics
• Sending your chart by mail
• Saving your charts
• Exporting a dataset to a file
• Publishing datasets to HANA

8.3.1 Sending your chart by mail

You can send your chart as a graphics file attachment in your default mail program.

Note:
If your chart is a table type, then it is attached to a mail as an Excel file attatchement, not a graphics
file.

There are two ways to send your charts:
• Directly from the chart
• Selecting a saved chart in the Share panel

Depending on which method you use, do one of the following:
• If you are in a chart, right click the chart and select Send By Mail
• If you want to choose a saved chart, click the Share button at the top of the application, select a

chart, and click the Send By Mail button.
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A new message is created automatically in your default mail application. The chart is attached as a
.PNG file.

Note:
When using the Share panel, you must ensure that no dataset is also selected when you select a visual.
If this is the case, the Send by Mail button will not be active. Unselect the dataset by clicking it to
reactivate the Send by Mail button. You can then select a visual to send.

8.3.2 Exporting a dataset to a file

You can export a dataset to one of these formats:
• C.S.V file
• MS Excel spreadsheet.
1. Click the Share tab at the top of the application window.

The saved datasets are listed in the Datasets pane.

2. Click a dataset.
3. Click the Export button in the menu bar.
4. Browse to a target folder and select the file type to save the dataset.
5. Click Export .

8.3.3 Publishing datasets to HANA

You can publish a dataset to SAP HANA . Only the dataset can be published. The associated
visualizations are not published.
1. Click the Share tab at the top of the application window.

The saved datasets are listed in the Datasets pane.

2. Click a dataset.
3. Click the Publish to Hana button in the menu bar.
4. Enter connection information and connect to the Hana instance.
5. Browse to a target cube and click Create new view .

The dataset is published as a new analytic view.

8.3.4 Publishing documents to SAP Streamwork
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You can publish documents including data and charts to an SAP Streamwork activity to share with a
Streamwork community. Before publishing to Streamwork you need to ensure that you have the following
information:

DescriptionInformation required

For example https://streamwork.comStreamwork URL

Your user name and password.
You have a valid login
to a Streamwork activi-
ty

If your network uses a proxy, you need to insert the server address and port
to use to allow Streamwork access on the Proxy tab of the Preferences dialog
box.

HTTP Proxy Server
address and port num-
ber

1. If your network uses a proxy server do the following before attempting to publish:
• Select File > Preferences
• Click the Proxy tab and select the "Needs HTTP Proxy " check box. Enter the HTTP Proxy Server

address and port number, and click OK.

2. Click Share on the menu bar at the top of the application window.
3. Do one of the following:

• Click on a chart in the Visualizations pane if you want to publish a chart only.
• Click on a dataset in the Datasets pane if you want to publish the dataset.
• Click on both dataset and charts to publish both.

4. Click Publish to StreamWork
A StreamWork authentication box appears.

5. Enter the StreamWork server URL, for example https://streamwork.com, your user name and
password, then click Connect.
The Publish Settings pane appears. You configure how you want your document to be published
to your StreamWork activity. You have the following options:

DescriptionSettings

Select if you want to publish a Visual Intelligence docu-
ment containing a dataset with all its associated charts.

Include SAP Visual Intelligence docu-
ment

Name of the document.Name

You can publish the dataset as an Excel spreadsheet,
or in CSV text format.Publish as

The Activity that you want to publish the document.To Activity

Comments describing your publication.Description
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Note:
The first time you connect, you may be required to enter further identification information depending
on your network settings. If this is the case, you receive an identification box requiring application,
name, customer key and secret details. You enter the following information then click OK to validate
the information:
• Application: Enter any text information, for example "StreamWork"
• Customer key: Enter:XrRVuEtbM7M6NqadR8fL
• Customer secret: Enter:g5WxtYr5flks1CbxlyMuRzHfxT7xUNpml4uNo3Cu

The StreamWork authentication box appears and you can enter the information described in the
previous table.

6. Enter the required information on the Publish Settings pane.
7. Click Publish.

The artifacts are published to the selected StreamWork activity.

Related Topics
• Setting application preferences

8.3.5 Publishing datasets to SAP Explorer

You can export a dataset to an SAP Explorer server that installed in an SAP BusinessObjects Central
Management Server (CMS). The dataset appears in SAP Explorer as a data source, and can then be
used to build an Information Space. An Information Space is a set of data objects that can be used
within SAP Explorer to build visualizations in a web browser that can be deployed over the SAP
BusinessObjects Business Intelligence platform, and on mobile devices.

Note:
You can only publish as dataset to SAP Explorer 4.0 SP4. Ensure that you have the correct version of
SAP Explorer before publishing.

1. Click Share on the menu bar at the top of the application window.
2. Click a dataset in the Datasets pane to the left of the Share panel.
3. Click Publish Dataset to Explorer in the menu bar at the top of the application pane.

A CMS connection box appears. You must enter the connection credentials to connect to the CMS
before publishing the dataset to an Explorer server.

4. Enter the following information:
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DescriptionCMS connection information

Name of the CMS server that houses the Explorer server.CMS server

User and password to connect to your user account.User/Password

The authentication protocol used by the server to log on users.Authentication type

5. Click Connect.
If the connection is successful, the folders used to store files in the CMS appear in the Folders List.
to the right of the connection box.

6. Browse to and select the target folder for the published dataset.
7. Click OK .

The dataset is published as an Excel file in the folder. In SAP Explorer the dataset appears as an
Excel datasource and can be used to build an information space.
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Managing SAP Visual Intelligence

9.1 Setting configuration parameters

You can customize certain configuration settings to optimize memory usage and the datapoint threshold
for charts. The parameters are stored in the SAPVisualIntelligence.ini file in the install path.
You can set the following parameters:

DescriptionDefault valueConfiguration parameter

Maximum number of datapoints permitted in a
chart before a message appears advising you to
filter or rank the values to reduce the data points.
You can increase this value to increase the
threshold.

Note:
If you increase the datapoint maximum you can
also consider increasing the virtual memory allocat-
ed to the application.

10000-Dhilo.maxvizdatasetsize

Virtual memory allocated to the application. If you
have 4 GB installed, then it is recommended to
allocate between 1024M and 2048M maximum to
SAP Visual Intelligence . If you have more system
memory, then you can increase the available
memory for SAP Visual Intelligence, ensuring you
keep sufficient memory to run the OS.

1024M-Xmx

1. Browse to this file: \\<INSTALL DIR>\SAP Visual
Intelligence\Desktop\SAPVisualIntelligence.ini.

2. Open the file in a text editor and set the required configuration parameters.
3. Restart the application to take into account the new parameters.

9.2 Setting application preferences
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You can modify the default settings for the following application features:

DescriptionPreference setting for...

Set the preferred view or mode to open when starting the application.Views

Default color and template choices for creating charts.Chart settings

You can choose how hierarchies are detected when data is acquired.Datasets

Choose how updates are downloaded from the SAP Service Marketplace
website and installed. You have the following choices:
• Manual update: You set the update schedule to None. To get updates

you select Check for NewUpdates from the Help menu and then select
to download and install updates if necessary.

• Scheduled update: You select an update check period and when an
update is available, you are notified by an indicator in the status bar.
You accept the update reminder and validate the download and instal-
lation of the update. The application requires a restart for the update
to take effect.

Auto-update

If your network uses a proxy server you enter the server address and port
number, with user and password information if necessary. This information
may be necessary for Auto-update and publishing to StreamWork activi-
ties.

Proxy

List of database middleware necessary for freehand SQL access.
Databases indicated by a red cross do not have the appropriate driver
installed. You need to download the driver from the vendor website and
copy the appropriate driver .JAR file to the driver folder in the SAP Visual
Intelligence installation path. This is described in the Working with Free-
hand SQL section in Related Topics. Database middleware indicated by
a green checkmark have the correct data access driver installed and can
be used for Freehand SQL access.

Freehand SQL

1. Select File > Preferences
2. Click a tab and set the required settings.

Related Topics
• Working with Freehand SQL
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